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1 Getting Started with HP Demand
Management

Introduction o HP Demand Management

HP Demand Management is the component of HP Project and Portfolio
Management Center (PPM Center) that manages requests from creation to
implementation. Each request is processed using a workflow that is
represented graphically in the user interface. HP Demand Management
features tools and configurable processes for dealing with these requests. Data
is captured by prompting for process-specific information to ensure that the
required information is collected and validated at the right time in the process.

HP Demand Management can follow complex business rules by using
different approval methods. Email and pager notifications can be generated as
the request passes through the various workflow steps. Prioritization and
delegation features allow requests to efficiently advance through the
workflows applied to them, routing them to the relevant department, group, or
individual.

This document contains the following information:

e In HP Demand Management, requests are the means by which actions and
processes are initiated and driven. Requests contain all of the information
required to take a series of actions that move requests through a workflow.
Chapter 2, Viewing Requests, on page 15 presents information about the
major features of HP Demand Management requests.

e You can use HP Demand Management to submit several different types of
requests, from simple software defect requests to project scope change
requests. Chapter 3, Creating Requests, on page 35 provides details on
how to create these.



e After you create a request, you process and manage it. Chapter 4,
Processing and Managing Requests, on page 61 provides instructions on
how to open and update requests, and how to use reports and portlets to
manage them.

e HP customers who have both HP Demand Management and HP Project
Management can integrate HP Demand Management’s request tracking
capability with HP Project Management’s deliverable date and actuals
tracking capabilities. Chapter 5, Integrating Requests and Projects,
on page 93 presents information on how to integrate and work with tasks
and requests.

e HP Demand Management supplies a preconfigured page that demand
managers can use to monitor and manage requests. Chapter 6, Demand
Manager Page, on page 97 provides descriptions of this page and the
portlets it displays.

Overview of an HP Demand Management System

10

An HP Demand Management request resolution system is used to track
requests from their creation to their resolution. The main components of a
request resolution system are requests and workflows.

Requests are the fundamental work unit in HP Demand Management. When
you ask for help, you create a request. When you report a problem, you create a
request. When something needs to happen, you create a request.

After you create a request, it must follow a process to reach its conclusion. A
workflow is the process a request takes to reach its conclusion. Workflows
consist of workflow steps, and each workflow step corresponds to a decision or
action.

At each workflow step, information can be added to the request or existing
information can be updated. For example, you might create an enhancement
request to ask for a change to an application. Later in the request resolution
process, after the enhancement request is approved, developers are assigned to
work on the enhancement.
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In PPM Center, you interact with the request through the request detail page.
The detail page displays all of the information about the request. This is where
you make decisions about and act on the request.

After the decision is made or the action completed, the user must manually
access the request detail page and select the decision or action. The request
then advances to the next step in the workflow, at which another user makes a
decision or takes an appropriate action.

Figure 1-1. Requests and workflows
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Requests, Request Types, and Request Status

The request detail page displays all of the information required to complete a
specific business process. Each request has an associated request type, such as
the Bug request type or the Enhancement request type. The request type
determines the basic features of the request, such as the fields it includes, its
participants, and the workflow it follows.

Request status is a summary indicator of the current state of a request. For
example, a request can have a request status of New, Assigned, or In Progress.
Request status is assigned automatically as the request moves through its
workflow. HP Demand Management comes with HP-supplied request types
that you can modify to meet your business needs.
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Worktlows and Workflow Steps

A workflow consists of a logical series of steps that define a process from
beginning to end. You can configure a workflow to handle virtually any
business process. You can create workflows to automate existing processes,
rather than forcing your organization to adopt a fixed set of processes.

Workflow steps are the events that are linked together to form a complete
workflow. HP Demand Management uses the following four types of
workflow steps:

e Decisions. In decision workflow steps, a user or group must make a
decision or take some action, such as approve a request or complete a task.
A decision workflow step is manually updated to indicate that the resource
made the decision or performed the action appropriate at that step.

e Executions. In execution workflow steps, the system performs an action,
and then updates the workflow step with the results. An execution can be as
simple as calculating the value for a token or as complex as creating
packages or updating Web pages. Execution workflow steps are
automatically updated to reflect the outcome of the action.

e Conditions. Condition workflows steps are logic steps, and can include
AND/OR statements. Condition workflows steps are used for complex
workflow processing, such as requiring that all inputs reach a workflow
step before the process can continue to the next step.

e Subworkflows. Subworkflow workflow steps are small, self-contained
workflows used by the workflow associated with the request.

Request Processing and Data Integrity

Information gathered during request resolution is often required to move a
request through its workflow. While some of the information related to a
request is available when the request is created, additional information is
acquired at different points along the workflow.

To acquire information when it is required at different workflow steps, HP
Demand Management uses conditional field behavior. Suppose, for example,
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that you enter a new request. At the outset, a field such as Assigned To is not
required, and might even be disabled.

At some point in the workflow, however, a user must be assigned to the
request. At that workflow step, the user or group working on the problem
might be required to fill in the Assigned To field. The (now required) field is
tagged with a red asterisk to indicate that the request cannot go to the next
workflow step until a user is assigned. In fact, the request cannot be saved
unless the Assigned To field is completed.

Related Documents

For more information related to HP Demand Management, see the following

documents:

e HP Demand Management Configuration Guide

e Tracking and Managing IT Demand User’s Guide

e Tracking and Managing IT Demand Configuration Guide
o HP Time Management User’s Guide

e HP Time Management Configuration Guide

e HP Project Management User’s Guide

® Reports Guide and Reference

e Getting Started

® What’s New and What’s Changed

e HP-Supplied Entities Guide includes descriptions of all HP Demand

Management portlets, request types, and workflows.

Gelting Started with HP Demand Management 13
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2 Viewing Requests

Overview of HP Demand Management Requests

An HP Demand Management request resolution system is used to track
requests from creation to resolution. HP Demand Management requests are
highly configurable. As such, actual sections and fields can vary between
different request types. Typically, each request type is associated with a unique
workflow.

To interact with a request, you use the associated detail page. The detail page
for a request contains all of the information about the request. Also, the detail
page is where decisions and actions that pertain to the request are executed.

Your PPM Center administrator can use HP Demand Management to create
Request Help content for any of the fields displayed on the details page for the
various request types. If your administrator has added Request Help for a field,
a Help icon [7] (Figure 2-1) is visible to the right of that field. To see more
detailed information about the field, click this Help icon.

Figure 2-1. Request Help icon

*Contact Hame: Schmict, Fredrick i 7

Contact (408) 9351222 [?
Phone:

Contact Email: fschmidti@mercuryl .com
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Figure 2-2 shows the detail page for a submitted (existing) request, with its
sections minimized. The main sections of the request detail page are as
follows:

16

The top of the detail page for a request displays the request type, request
number, and the Available Actions section. The Available Actions section,
when expanded, displays the actions you can perform on the request at the
current workflow step. The information presented in this top area of the
detail page is available after a request is created and submitted.

Header. The Header section displays general information such as who
created the request and on what date, and the request type. As you create a
request, you must usually complete some of the fields in the Header
section. After you submit the request, you can update information in any
active fields. The Header section is available after a request is created.

Details. The Details section displays information specific to the request,
such as a description of the problem, the business area affected, and what is
required to resolve the request. As you create a request, you must usually
complete some fields in the Details section. After you submit the request,
you can update information in any active fields. The Details section is
available immediately after the request is created.

Notes. Use the Notes section to add notes and to view any existing notes
already submitted on the request. You can add notes when you create a
request as well as later, after you submit it. The Notes section is available
immediately after you create a request.

Status. The Status section displays request status and is available after you
create and submit a request.

References. You use the References section to display or add additional
information about the request. For example, you can add a document or
URL as a reference to a request. The References section is available
immediately after you create a request.
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Viewing Requests

Figure 2-2.
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Opening a Request

There are several ways to open requests in PPM Center. The following
procedure provides the steps you use to open a request from the Search
Requests page in the standard interface.

To open a request:
1. Log on to PPM Center.
2. From the menu bar, select Demand Management > Search Requests.
The Search Requests page opens.
3. In the available fields, enter your search criteria, and then click Search.

The Request Search Results section lists the requests that match your
search criteria.

4. In the Req # column, click the number that corresponds to the request you
want to open.

The request detail page opens and displays all of the information related to the
selected request. To view the next request in your search results, click the
right-pointing arrow button in the upper right corner of the page.

Request Detail Page, Top Section
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The top of the detail page for a request displays the request number, the request
type, and the Available Actions section. The top section is visible after a request
is created and submitted. The title of the request detail page is <Request Type>
- <Request Number> (for example, DEM - Application Bug - #30182).

From the title section, you can:
e Perform an available action
e Print the request details

e Save the request
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e Make a copy of the request

e Delete the request

e Expand or collapse all sections on the page
e Jump to the Status and Notes sections

If you have the permissions required to act on the request at the current
workflow step, the Available Actions section lists the actions you can take.
Some actions, such as Accept and Reject, move the request to another step in
the workflow. If you select an action such as Assign Resource or Delegate
Decision, a workflow action page opens to present additional choices. Some
actions change optional fields to required.

Reference relationships let you place a request on hold until another request is
completed. In these reference relationships, the Available Actions section
contains the Override button. To allow the request to proceed through the
workflow, you click Override. When a relationship is overridden, the change is
reflected in the References section.

Request Detail Page, Header Section

The Header section of a request’s detail page contains general information
concerning the request, such as who created the request, the date, and the type
of request. The Header section is included in the request creation process and
continues with the request until resolution. Typically, when creating a request,
you need to complete some of the fields in the Header section. (Figure 2-3
shows a typical Header section). However, requests are highly configurable.
As such, the fields in a Header section can vary between different types of
requests.

Viewing Requests 19



Figure 2-3. Request detail page, Header section

=i Header

= Summary
Request Ho.: 20251 Requested By: Admin User
Request Type: DEM - Application Enhancement [ChsAge Created On: October 29, 2008

Request Status: Hew

Workflow: DEM - Enhancement Reguest Process
Assigned To: Calvin Wu = =8l
Assigned Group: TG Resource Manager ﬂ
Requestor Department: Corporate Finance v

Priority: High v Application: ERP Application =)
Description: Show vesting optiens to users

Request Detail Page, Details Section
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The Details section of a request’s detail page (see Figure 2-4) contains
information specific to the request, including a description of the problem, the
business area affected, and the resolution of the request. The Details section is
included in request creation and continues with the request until resolution.
Typically, when creating a request, you must complete some of the fields in the
Details section. After a new request is submitted, various fields must be
updated as the request proceeds through the resolution process.

The Details section contains several subsections, including Problem/Resolution
and Analysis. However, requests are highly configurable, and the sections and
controls displayed vary depending on request type.

Figure 2-4. Request detail page, Details section

=l Details

=l Enhancement Details

Enhancement Name: esting options

Detailed Description: User need to see entire schedule for options

New Enhancement: @ves Onio Suite: DEV v
Requested By: December 17, 2008 =
Requestor Location: US West v Business Initative: CRM phase 1 v
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Request Detail Page, Notes Section

The Notes section of a detail page contains fields where notes and information
concerning the request can be entered and stored. The Notes section is included
in the request creation process and continues with request until resolution.

Figure 2-5 shows a typical Notes section. All Notes sections include the Add
Note section. The Existing Notes section is displayed after the first note is
added and the request is saved.

Figure 2-5. Request detail page, Notes section

=l Notes

= Add Notes

lNotes to be added on save:

= Existing Notes
[] show Only User liotes Note Author: | ALL v Changed Field: | ALL %

Admin User (admin) New

February 7, 2008 10:28:18 AW PST The herizontal serolbar appears to be broken in some browser. Testing s in progress

Request Detail Page, Resources Section

If your PPM Center administrator has enabled resource tracking for the request
type, the request detail page displays the Resources section under the Details
section. The Resource column in this section lists the resources assigned to the
request so far. The section may also include Scheduled Effort, Actual Effort,
Actual Start, and Actual Finish columns (see Figure 2-6).

Figure 2-6. Request detail page, Resources section

=l Resources (1 Resource[s] Exist)

Resource Scheduled Actual Actual Actual
Effort Effort Start Finish
(hrs) (hrs)

= Eliot Packer 10.00 0.00

Overall: 10.00 0.00

Add Resource

=l Notes
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In the Resources section, you can see who is assigned and who was previously
assigned to the request, what effort they contributed, and when they
contributed that effort. Any time the Assigned To field changes (any time you
the request is assigned to a different resource), that resource is automatically
added to the Resources section, and is on the request.

You can use the Resources section to update your actuals, and, if you have the
required permissions, you can use the Scheduled Effort (hrs) field to change
allocations for the listed resources. Creating and changing allocations for
resources assigned to a request is typically done by a manager-level resource.
Other resources who work on the request typically do not have permission to
make planning changes, and thus, cannot modify the Scheduled Effort (hrs)
field.

If your administrator has configured the request type to use HP Time Management,
then resources are expected to submit time sheets and log the time they worked on
this request. In this case, the value in the Scheduled Effort field for a resource is
displayed in the Expected Hours field on the time sheet for that resource.

In addition, after a resource submits a time sheet, he cannot edit the Actual Effort,
Actual Start, and Actual Finish fields directly on the request. These values are now
read-only, and are rolled up from the time sheet(s) submitted by the resource for the
request.

If your administrator has authorized you to manage the Resources section, you
can use the Add Resource button to select and add users to the list. The
information displayed here may come from changes made to this section, from
time sheets in HP Time Management, or from an advanced UI rule configured
by an administrator to set up automated changes to resources.

If, in addition to being configured to track resources, the request also includes
the Work Item Fields section, then some of these work item fields become
roll-ups of the resource-level information. So, for example, the information in
the Scheduled Effort column in the Work Item Fields section is a sum of the
scheduled effort specified for each resource on the request. The Actual Effort,
Actual Start Date, and Actual Finish Date fields also become rollups.
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Request Detail Page, Status Section

The Status section of a request’s detail page lists the workflow steps associated
with a request. If a workflow step has been acted on, the status of the workflow
step and who completed the step are also listed. Workflow steps can be linked
to a Web address (URL) which might describe the workflow step or provide
some other information. The active workflow step is highlighted.

If you have the permissions required to act on the active workflow step, a View
Available Actions link is displayed in the Step Status column (Figure 2-7).
Click the link to access the workflow step’s available actions. Note that the
available actions are also shown in the Available Actions section of the title
section (see Request Detail Page, Top Section on page 18).

Some workflows include subworkflows. Subworkflow steps are displayed
sequentially with the other workflow steps. Subworkflow steps are numbered
with additional decimal places, corresponding to the workflow level (for
example, 3.1, 3.2, and 3.3).

In addition to the list of workflow steps, the Status section includes the
following links:

e Graphical View displays the workflow associated with the request.

e Approval Details displays a detailed view of approved and completed
workflow steps.

e Transaction Details displays detailed information of each completed
workflow step transaction.
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Figure 2-7. Request detail page, Status section
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22 Close (Immediate success
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Request Detail Page, Graphical View

The Graphical View link on a request detail page opens the Graphical
Workflow window, which displays a graphical representation of the workflow
applied to the request. The workflow shows which workflow steps have been
visited and which workflow step is the current workflow step.

To see the graphical workflow for a request.

1. From the standard interface, open a request.

) For information on how to open requests, see Opening a Request on page 18.

2. On the detail page, scroll to, and then expand the Status section.
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3. At the bottom of the Status section, click the Graphical View link.

The Graphical Workflow window opens.

2 Graphical Workflow [HP] - Microsoft Internet Explorer provided by Hewlett-Packard

(D] [Close Window =
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The Legend section provides a key to the colors and symbols used to illustrate
the workflow steps and transitions. To see a summary description of a
workflow step, move your cursor to the step to view the tooltip text.

Your administrator can assign a Current %Complete value to individual
workflow steps. As the request moves along the workflow, the percent
completed is updated according to the value configured for each step.
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Request Detail Page, Approval Details

The Approval Details window for a request displays a detailed view of
approved active and completed workflow steps.

To view the approval details for a request:

1. From the standard interface, open a request.

) For information on how to open requests, see Opening a Request on page 18.

2. On the detail page, scroll to, and then expand the Status section.
3. At the bottom of the Status section, click Approval Details.

The Approval Details window opens.

(D] Ciose Window X »

Approval Details - DEM - Application Bug #31604

Request Status: |n Further Review

Description: Application faile when aving after using new Ops module

Active Workflow Steps

7 - Request Analysis Eligible since February 7, 2008; Only one user must decide (no deadline)
Decision Results Approvers Decision Date

[No Decision] Securty Group: TG Administrator

Completed Workflow Steps

1 - Priority Router High; Only One user needed to decide

Decision Results Approvers Decision Date

High Eliot Packer February 6, 2008 02:38 PM PST
3 - Initial Review Assign; Only One user needed to decide

Decision Results Approvers Decision Date

Assign admin user February 7, 2008 10:08 AM PST

Done
v

>

<

The Approvers columns list the names of the security groups whose members
can act on the workflow step (or, if a workflow is completed, the security
groups whose members have acted on the step). The Approval Details window
also displays any conditions required to complete a workflow step (for
example, All Users Must Decide).

Depending on how the workflow step is configured, the Approvers column
lists the name of the security group, or the names of individual users. To
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display the names of the users who belong to a listed security group, click the
security group name.

A workflow decision step can have many different results. The Decision
Results column displays the actual result of the workflow step. The Decision
Date column displays the calendar date on which the decision result occurred
(after all required approvers and decision makers submitted their input).

Request Detail Page, Transaction History

The Transaction Details window lists information for each completed
workflow step transaction.

To view the transaction details for a request:

1. From the standard interface, open a request.

) For information on how to open requests, see Opening a Request on page 18.

2. On the detail page, scroll to, and then expand the Status section.
3. At the bottom of the Status section, click Transaction Details.

The Transaction Details window opens.

2 Transaction Details - DEM - Application Bug #31604 [HP] - Microsoft Internet Explorer provided by Hewlett-Packard E”E\E|
[ (D ] [Close Windaw X

Transaction Details - DEM - Application Bug #31604

Date Username Step Workflow Step Hame Step Status Results Error Error Message Notes
February &, 2008 02:39 PM PST epacker 3 Initial Review Eligible

February 7, 2008 10:09 AM PST admin 3 Initi
February 7, 2008 10:08 AM PST admin 7 Reques

Complete: Assign

rsis Eligible
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Request Detail Page, Request Execution Log

You can view the details related to the execution workflow step for a request
by opening the Request Execution Log page.

To view the request execution log for a workflow step:

1. From the standard interface, open the request of interest to you.

For information on how to open requests, see Opening a Request on page 18.

2. On the detail page, scroll to, and then expand the Status section.
3. In the Step Status column for an execution step, click log.

4. The Request Execution Log page opens and displays the details of the
request execution.

Request Detail Page, References Section

28

The References section of the request detail page contains additional
information related to the request. For example, you might add a URL to a
request or delete an outdated document from a request. The References section
is included in the request creation process and remains through to request
resolution. References can be added or deleted from the request.

Use the Reference Additions subsection to add references to the request. Saved
references are organized based on reference type. For example, all saved
reference packages are saved in the Packages section.

In some cases, you can create a functional dependency between a request and
the referenced entity. For example, you can specify that a package is a
predecessor to the request. This means the request cannot continue to the next
workflow step until the package is closed. For a list of the references, their
definitions, and possible dependency relationships, see Table 2-1 on page 29.

Chapter 2



Figure 2-8. References section of the request detail page

=i References

E Projects

Hame

AS Project 08.23 ..

Project Status
Manager/Resource

admin user Assign Project

lanager

B rogram:

Hame

us_E2E
programz

Program Manager Status

program manager e2e1 New

Reference Additions

New Reference: | Attachment

v Add

References to be added on Save:

Relationship
Complete

0% Related to this Reguest

Relationship

Related to this Reguest

Relationship Details

P Informational: Project 31523 is
related to Requ 204

Relationship
Details

P Informational: This Program is
related to the referenced

Table 2-1. References and relationships (page 1 of 4)

. Possible Relationship
Reference | Reference Description | o (7" 1. ps | Description
Attach a file from a
local machine to the Standard (Informational) The
Attachment | current request. The attachment attachment is related to
attached file is copied interaction this request.
to the server.
Child of this (Informational) Th(_e
request selected package is the
q child of the request.
Related to this (Informational) Thg
request selected package is
q related to the request.
Packages Reference an existing (Blocking) Action is not
(Existing) package. allowed on the request
Predecessor .
until the referenced
package closes.
(Blocking) Action is not
allowed on the
Successor

referenced package
until the request closes.

Viewing Requests
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Table 2-1. References and relationships (page 2 of 4)

- Possible Relationship
Reference | Reference Description Relationships | Descripfion
New packages can | Childof this | Uniormational) The
also be created from a | request selecled package Is the
request. child of the request.
If configured as part of . (Informational) The
the workflow, you can rReeIEteesctl to this selected package is
spawn a package from q related to the request.
a workflow step. When - ——
(F"\?gvlf/?ges this happens, a (Blocking) Action is not
reference to that Predecessor aIIo_wed on the request
package is until the referenced
automatically package closes.
generated,fastabllshlng (Blocking) Action is not
a two-way link between allowed on the
the request and Successor referenced package
package. until the request closes.
Reference a project in . (Informational) Selected
Projects HP Project Related to this project is related to this
request
Management. request.
Reference a release in Contains this (Informational) The
Releases HP Deployment request is contained in

Management.

package

the selected release.
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Viewing Requests

Table 2-1. References and relationships (page 3 of 4)

- Possible Relationship
Reference | Reference Description | o onships | Descripfion
. (Informational) The
Duplicate .
request referenced request is a
q duplicate of the request.
- (Informational) The
Original .
. referenced request is
duplicate -
the original of the two
requests .
duplicate requests.
(Informational) The
Parent of this referenced request is
request the parent of the
request.
Requests Reference an existing | Child of this (Informational) The .
. referenced request is
(Existing) request. request

the child of the request.

Related to this
request

(Informational)
Referenced request is
related to this request.

Predecessor

(Blocking) Action not
allowed on this request
until the referenced
request closes.

Successor

(Blocking) Action not
allowed on the
referenced request until
this request closes.
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Table 2-1. References and relationships (page 4 of 4)

Reference

Reference Description

Possible
Relationships

Relationship
Description

Requests
(New)

You can create new
requests from an
existing request.

Also, if configured as
part of the workflow,
you can spawn a
request from a request.
A reference to that
request is
automatically
generated, establishing
a two-way link between
the requests.

(Informational) The

Duplicate .
request referenced request is a
q duplicate of the request.
- (Informational) The
Original .
. referenced request is
duplicate -
the original of the two
requests

duplicate requests.

Parent of this

(Informational) The
referenced request is

request the parent of the
request.

Child of this (Informational) The_
referenced request is

request

the child of the request.

Related to this
request

(Informational)
Referenced request is
related to this request.

Predecessor

(Blocking) Action not
allowed on this request
until the referenced
request closes.

Successor

(Blocking) Action not
allowed on the
referenced request until
this request closes.

Tasks

Reference a task in HP
Project Management.

Related to this
request

(Informational) The
referenced task is
related to this request.

URL

Reference a Web
address. Documents at
the URL must be in
MIME format.

Standard URL
interaction

(Informational) The URL
is related to this request.

32
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Predecessor Relationships

Predecessor relationships dictate that an action cannot be performed on one
entity until the referenced entity closes. For example, an action is not allowed
on a request until the referenced package closes. After the package closes,
users can again act on the request. (This does not prevent users from editing
other request fields.)

Successor Relationships

Successor relationships dictate that action is not allowed on a referenced entity
until the entity closes. For example, users cannot perform an action on a
referenced package until the request closes. The package status is Pending
Request. After the request closes, users can act on the package again. This does
not prevent users from modifying other task fields.

Finish/Finish Predecessor Relationships

Finish/Finish, or FF, predecessor relationships dictate that the two entities
complete at the same time. For example, a referenced package cannot have a
status of Complete until the original request is closed. After the resource
working on the original request is finished, and the status is set to Completed
(% Complete is set to 100%), the referenced package acquires Completed
(Pending Request) status. After the request is closed, the referenced package is
set to Completed. (This does not prevent users from editing other request
fields.)
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3 Creating Requests

Overview of Creating Requests

In HP Demand Management, requests are the means by which actions and
processes are initiated. Requests contain all of the information necessary to
take a series of actions and move through a workflow.

The information that a request contains depends on what type of request it is.
For example, if you create an enhancement request, the information you
provide is different than if you create an application defect request. However,
most request types have the same basic organization.

Figure 3-1 on page 36 shows a request detail page that is minimized to show
only the main sections. The following are the main sections on a request detail

page:

e The Header section contains general information such as the request type,
who created the request, and on what date.

e The Details section contains information specific to the request, such as a
description of the problem, the business area affected, and the resolution of
the request. Typically, when creating a request, you’ll be required to
complete some of the fields in the Details section.

e The Notes section provides fields for entering information about the
request that you want to keep. Entering notes is optional.

e Use the References section to add and view additional information about
the request. For example, you can attach a document or specify a URL as a
request reference.
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Figure 3-1. Request detail page with some header sections minimized

PFM - Proposal - #30330

Deseription:  Upgrace DB version
Request Status:  hevy (view Ful Status Below)

Ho Available Actions

Make a Copy Delete
Expend Alll Collapse Al Save

= Header
g s ary
Proposal llo.: 30330 Created By: David Jores
Driving Process: FFM - Proposal
Business Unit: v Status: MNew
Description: Upgrace DB version
Request Type: PFM - Propossl [Ehsnas|
Project Type: [ | Region:
Proposal E

Dependencies:

# Details
# Notes Mo Mates Exist
= Status
Seq Workflow Step Hame Step Status Completed By Date
1 Proposal Review Eligikle: February 20, 2007 10:33:15 AM PST
2 Buiid High Level Business Case
3 Lewel1 Approval
4 Build Detailed Business Case
B Finance Revigw
6 Standards Commitiee Review
7 Biz Ops Council Review
] IT Steering Committes Review
10 Create Project
1 Proposal Closed (Approved)
12 On Hold
13 Project Reguest Rejected
Grephicel Yiew | Approvel Detsls | Transaction Details Cancel Request]
# References 1 Reference Exists

Make a Copy Delate

For more information about request detail pages, see Viewing Requests
on page 15.
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Creating a Request

Creating Requests

To create requests, you use the Create New Request page, which you can
access from the following locations (and which is described in detail in
subsequent sections):

Menu bar

References section on a request detail page
From an HP Project Management project

From an HP Project Management task

From an HP Deployment Management package

From an HP Deployment Management release

For information on how to create a request from HP Project Management, see
Integrating Requests and Projects on page 93. For information on how to
create a request from HP Deployment Management, see the HP Deployment
Management User’s Guide.
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Creating Requests from the Menu Bar

The most common way to create a request is by using the menu bar. After you
create a request, it is automatically assigned a unique number and then tracked
from start to finish. This ensures task completion and accountability for all

steps within the request’s workflow.
To create a request:

1. Log on to PPM Center.

2. From the menu bar, select Demand Management > Create a Request.

The Create New Request page opens.

A Project and Portfolio Management Center

SIGN OUT

Dashboard - Front Page > Create A Request > Create New DEM - i * Search Reguests > Create A Regquest

Welcome, admin user
Febs, 2008 025r0armpst © Create New Request
Lest Login: 2/2/08 09:52 AM FST

Expand Al Collapse All
Dashboard

‘Request Type: | v Create

[ Demand Management
Search Requests
Manage Consolidated Deman:

Schedule Demand - .
Analyze Demand by Categon Create Based On Desired Action
e e —— Most Recently Created

Demand Reports Release Management

Saved Searches PFH - et

Request Browser Report an Application Bug

Project Management

test
Resource Management
ua_rd_rt15

Program Management

Time Management Miscellaneous PFM_6.0_Category_for_PFM_RT_with_added_PFM_Fields_Group

Portfolio Management

3. From the Request Type list, select the request type to create.

The request type you select depends on your licenses and access grants,
and on the security groups to which you are assigned. To save you time, the
Create Based on Desired Action section lists the most recently created

request types.
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4. Click Create.

The Create New <Request Type> page opens.

Create New DEM - Application Bug

[Expand Al [Collapse a1l Submit Cancel

= Header
B Summary
Requested By: Admin User
Request Status: Unreleasacd
Workflow: DEM - Bug Request Workflow: |7

Assigned To: l:l = B
Assigned Group: |:| [ JH
Reuestor epartment

*Deseription: [ |

=l Details

= Problem/Resolution

‘Problem:

Reproducible: Oves Ono 7

Steps to Reproduce:

Resolution: A

Solution:

L]

Environment

L.

Analysis

#H Project Information

# pemand Management SLA Fields

# Demand Management Scheduling Fields
# Notes

# References

Submit Cancel

The sections displayed on the request detail page vary, depending on the
request type you selected.
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10.

. In the Header section, complete the fields, as required.

The Header section contains fields for entering general information about
the request. Required fields are marked with a red asterisk. All other fields
are optional, but you can use them to provide information that can be useful
to others reviewing the request.

In the Details section, complete the required fields, and provide any other
information about the request that might be useful.

The Details section can have none, one, or many subsections. For
information about a specific field, click the Help icon (if available) next to
the field.

In the Notes section, type additional information about the request that you
want to make available to other users.

Use the References section to add references to the request.

You can reference a Web-accessible file or attach a document or file from
your local machine to the current request. You can also reference packages,
tasks, and other requests. For more information on how to add references,
see Overview of Adding References to Requests on page 47.

. Click Submit.

The Request Creation Confirmed page opens and displays the number
assigned to the new request, and the request description.

PPM Center can be configured to save requests before they are submitted. To
have this feature enabled for your site, see your application administrator.

To see the generated detail page for a submitted request, click Request #.

After you submit a new request, HP Demand Management assigns it an initial
status, such as New, and then routes it along a standard business process of
approvals, decisions, and actions, depending on the associated workflow. For
more information, see Processing and Managing Requests on page 61.
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Creating Requests from the References Section

You can create a request from the References section of the detail page for a
request.

To create a request from a References section of a request detail page:
1. Log on to PPM Center.
2. From the menu bar, select Demand Management > Search Requests.
The Search Requests page opens.
3. To locate a request, enter search criteria, and then click Search.

4. In the Request Search Results section, in the Req # column, click a number
to open the corresponding request.

The detail page for the request opens.
5. Scroll to, and then expand, the References section.
6. From the New Reference list, select Request (New).
7. Click Add.

The Create New Request page opens.

3 Create New Request [HP] - Microsoft Internet Explorer provided by Hewlett-Packard il E
~

(D] [Close Window X .

Create New Request

“Relationship:

© Duplicate Request - (Informational) - The selectsd Request is a duplicate of Request 30510
(@] Qriginal of Duplicate Requests - (Informational) - The selected Request is the Original of these two duplicate Requests

© Parent of this Reguest - (Informational) - The selected Request is the parent of Request 20510

O Child of this Reguest - (Informational) - The selected Request is the child of Request 30510
@ Related to this Request - {Informational) - The =elected Request is related to Request 30510

0510 closes

(O successor - (Blocked) - Action not allowed on ssiected Regusst untl Requ

O Predecessor - (Blocking) - Action not allowed on Request 30510 until the selected Request closes

Create Cancel

@1 Done ‘_-g Local intranet

£
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10.

1.
12.

>»

13.

. From the Request Type list, select the type of request you want to create.

Under Relationship, select the option that indicates how the new request is
related to the request you opened.

For more information about establishing relationships between requests, see
Overview of Adding References to Requests on page 47.

Click Create.
The Create New <Request Type> page opens.
In the fields marked with a red asterisk, provide all required information.

Provide any additional information about the request that might be useful.

For instructions on how to complete the Create New <Request Type> page, see
Creating Requests from the Menu Bar on page 38.

Click Submit.

Creating Requests by Copying Requests

You can copy an existing request to create a request. This can save you time by
eliminating the need to re-enter information that is common to both requests.

To copy an existing request:

1.
2.

42

Log on to PPM Center.

Open a request.

To open a request, see Opening and Updating Requests on page 68

The detail page for the request opens.
Above the Header section, click Make a Copy.

The Copy Request page opens.
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4. To add the notes associated with the original request to the new request,
leave the Copy Request Notes checkbox selected.

5. To add the references associated with the original request to the new
request, leave the Copy Request References checkbox selected.

6. Click Copy.

The Create New <Request Type> page opens and displays the copied
information. The values from all the fields in the Header and Details
sections are replicated in the new request.

7. Modify the field values, as required, and then click Submit.

Assigning Resources to Requests

When you create or edit a request, you can manually assign resources to a
request from the Summary section of the request detail page, or, if your
administrator has enabled resource tracking, from the Resources section of the

page.

Assigning Resources from the Summary Section of the Request Detail Page

To assign an individual resource from the Summary section of the request
detail page:

1. To the right of the Assigned To field, click the resource selector icon &l
A search and select window opens.

2. Do one of the following:
e Scroll through the listed resources, and select the resource to assign.
Alternatively, to restrict the number of resources listed:

a. Enter search preferences in any combination of the Assigned To,
Department, First Name, and Last Name fields.

b. Click Find.

Creating Requests 43



c. From the list of resources returned, select a resource name.

The search and select window closes, and the Assigned To field displays
the selected resource name.

To add the resource, you must save the request or, if this is a new request, submit
the request.

To assign multiple resources from the Summary section:

1.

44

To the right of the Assigned To field, click the resources selector icon g

The Select Resource to Assign page opens.

. Use the Availability within dates fields to specify the date range during

which the resources must be available for assignment.
To specify that the resources must have a specific skill:
a. Click Skill.
b. Use the auto-complete that becomes available to select a skill.

c. In the Ideal Proficiency list, select the proficiency level you require of a
resource with this skill.

To further restrict your resource search results, you can enter values in the
following fields:

e To specify a minimum suitability score, enter a different value in the
Only show results with a Suitability Score greater than field.

The suitability score is a numeric score that represents the suitability of the
resource for the request, based on role, skills, and availability. The higher the
score, the better suited the resource is for assignment to the request. For
more information about suitability score, see the HP Resource Management
User’s Guide.

e Use the Resource Name auto-complete to select multiple resources by
name.

e Use the Role auto-complete to select one or more roles that the
resources must assume.
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e Use the Resource Pool auto-complete to select

e Use the Organization Unit auto-complete to select an organization unit
to which the resources must belong.

e Use the Resource Category auto-complete to select one or more
category to which the resources must belong.

e From the Location list, select the site where the resource must be
located.

e From the Department list, select the department to which the resource
must belong.

5. Click Search.
The Resource Results tab lists the resources that meet your search criteria.

6. To view the workloads of listed resources for the date range you specified,
select the checkboxes for the resources of interest to you, and then click
View Resource Load.

The Resource Load Breakdown - Assignment Summary window opens and
displays the work allocations for the selected resources over the specified
time period.

7. To compare the skills of two or more of the listed resources, select the
checkboxes for the resources of interest to you, and then click Compare
Skills.

The Compare Skills window opens and displays the skills and skill levels
for each selected resource.

) To add the resource, you must save the request or, if this is a new request, submit
the request.

Creating Requests 45



Allocating Resources from the Resources Section of the Request Detail Page

If your administrator has enabled HP Demand Management’s resources
tracking functionality, and has given you the required authorization, you can
manage resource allocations on a request from the Resources section of the
request detail page.

To allocate a resource to a request from the Resources section:
1. On the request detail page, expand the Resources section.
2. Click Add Resource.
A search and select window opens.
3. Do one of the following:
e Scroll through the listed resources, and select the resource to assign.
Alternatively, to restrict the number of resources listed:

a. Enter search preferences in any combination of the Assigned To,
Department, First Name, and Last Name fields.

b. Click Find.
c. From the list of resources returned, select a resource name.

The search and select window closes, and the Resources section displays
the selected resource name.

4. To commit the resource(s) you just added, do one of the following:
e [If this is a new request, click Submit.

e Otherwise, click Save.
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Overview of Adding References to Requests

You can use the References section on the request detail page to add (and
view) supplementary information related to the request. For example, you

might add a document or the URL for a Web page that provides more
information about the request.

You can associate the following reference types with a request:

e Attachments

e Packages (new and existing)
e Other programs

e Projects

e Releases

e Requests (new and existing)
e Tasks

e URLs

For some references, such as packages and other requests, you can establish a
functional dependency to the original request. For example, you can specify
that a request is a predecessor to the package so that the package cannot
continue along its workflow until the request is closed. For a list of the
references and their possible dependency relationships, see Request Detail
Page, References Section on page 28.

Creating Requests

47



Adding References to Requests

This section provides the steps you perform to add different types of references
to a request.

Adding Attachments as References

To add an attachment as a reference to a request:

1.
2.

48

Log on to PPM Center.

Open or create a request.

Scroll to, and then expand, the References section.
From the New Reference list, select Attachment.
Click Add.

The Add Document window opens.

In the File field, type the name of the document file to attach as a reference.

The file name you attach must not contain an apostrophe. If it does, a script error
will occur the next time the request is opened.

. In the Author field, you can replace your name with the name of the

attachment author.
In the Description field, you can type a description of the attachment.
Click Add.

On the request detail page, the References to be added on Save field lists
the referenced attachment.
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10. Click Save.

>»

To add the reference, you must save the request or, if this is a new request,
submit the request.

Adding Existing Packages as References

You can reference existing packages to a request.

To reference an existing package:

1.
2.

Creating Requests

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Package (Existing).

. Click Add.

The Add Reference: Package window opens.
Enter your search criteria in the available fields.
Click Search.

The Package Search Results section lists the packages that match your
search criteria. The section also includes a list of relationship types.
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8. Under Select which relationship the selected packages will have to Request
# <request number>, click the option that describes the relationship

10.

1.

between the request and the package.

Add Reference: Package

‘Select which relationship the selected Packages will have to Request 230256:

O child of this Reguest - (Informational) - The selectad Package is the child of Reguest 30256

(&) Related to this Request - (Informational) - The selected Package is related to Request 30255
) Predecessor - (Blocking) - Action not allovwed on Request 30256 until selected Package closes
) Successor - (Blocked) - Action not allowed on selected Package urtil Request 30256 closes

Package Search Results

Pkg &7
30032

O

0 30029
[ 30018
[ 30008
[ 30007

Check All

‘Workflow
DEY = TEST = PROD

DEY = TEST = PROD
DEY = TEST = PROD
DEY = TEST = PROD

DEY = TEST = PROD

In Progress

Priority
Mormal
Mormal
Mormal
Mormal

Mormal

Assigned To

csayer
hhaywood
csayer
caayer

ceayer

Showing 1 - 5 of 5

Pkglines  Deseription
Fatch v3 migration test

Upgrede for release 7.0b

Patch v4a migration test

4 Patch v3 migration test

Showing 1 -5 of

‘ Modify Searuh‘ Cancel |

In the Package Search Results section, select the checkbox(es) next to the
name(s) of the package(s) to add.

Click Add.

On the request detail page, the References to be added on Save field
displays the package name and its relationship to the request.

Click Save.

The Packages subsection of the References section now lists the
referenced package.

To add the package as a reference, you must save the request.
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Adding New Packages as References

Creating Requests

You can create a new package to add as a request reference.

To reference a new package:

1.
2.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Package (New).

. Click Add.

The Create New Package window opens.

Under Relationship, select the option that describes the relationship
between the new package and the open request.

Click Create.

The New Package window opens. Any matching header information from
the request (such as description, priority, and package type) is
automatically added to the package.
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New Package 30034

Save Cancel

Header
‘Package HNo.: PackageGrowpz | |[E createdsy: Admin User
Description: |This intistive suiuresses Phase 2 of the overhaul | Created On March 5, 2007
“‘Workflow: | | [ ] Status: ey

Assigned User: Carolyn Sayer & Priority: Parent:
Assigned Group: TG Deployment Managemd 35| Package Type: Priority Seq:
]

Percent Complete:

Notes

Hotes to be added on save:

References

Reference Additions

Hew Reference: | Aftachment v Add

References to be added on Save:

Open Remove

Save Cancel

8. Provide all required information, and any optional package information
you want to make available, and then click Save.

On the request detail page, the References to be added on Save field lists
the new package name.

9. Click Save.

0 To add the package as a reference, you must save the request.
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Adding Programs as References

Creating Requests

You can reference existing programs to a request.

To reference an existing program:

1.
2.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, sclect Program.

Click Add.
The Reference Program window opens.

In the Program field, type the name of the program you are adding as a
request reference.

Under Relationship, select the option that describes how the program is
related to the request.

Click Add.

On the request detail page, the References to be added on Save field lists

the program name and displays its relationship to the request.

. Click save.

To add the program as a reference, you must save the request.
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Adding Projects as References

To attach existing projects as a reference:

1.
2.

10.

Log on to PPM Center.
Open or create a request.

In the request detail page, expand the References section.

. From the New Reference list, select Project.

. Click Add.

The Add Reference: Project window opens.

. Provide the required information, and any optional information you want to

record, and then click Search.

The Add Reference: Project window lists relationship types and the
projects that match your search criteria.

Under Select which relationship the selected Projects will have to Request #
<request number>, select the option that describes how the project(s) is
related to the request.

In the Select Project to View section, select the checkbox(es) for the
project(s) you want to add as a reference to the request.

. Click Add.

On the request detail page, the References to be added on Save field lists
the project name and displays its relationship to the request.

Click Save.

To add a reference, you must save or submit the request.

The detail page for the request now lists the selected project(s).

54

Chapter 3



Adding Releases as References

You can add existing releases as references to requests.

To reference an existing release:

1.
2.

Creating Requests

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Release.

. Click Add.

The Reference Release window opens.
In the Release field, type the release version.

Under Relationship, select the option that describes the relationship that the
release has to the open request.

Click Add.

On the request detail page, the References to be added on Save field lists
the release name and displays its relationship to the request.

Click Save.

To add the release as a reference, you must save the request.
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Adding Existing Requests as References

You can add existing requests as references to requests.

To reference an existing request:

1.
2.

10.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Request (Existing).

. Click Add.

The Add Reference: Request window opens.

To locate the request to reference to the open request, enter your search
criteria, and then click Search.

The Add Reference: Request window lists the possible relationship types.
The Request Search Results section lists the requests that match your
search criteria.

. Under Select which relationship the selected Requests will have to Request

# <request number>, select the option that describes how the request you
are about to select is related to the open request.

. In the Request Search Results section, select the checkbox(es) for the

request(s) you want to add.
Click Add.

On the detail page for the request, the References to be added on Save field
lists the selected request(s).

Click Save.

To add the reference, you must save the open request.

In the References section of the request detail page, the Requests subsection
lists the referenced request(s).
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Adding New Requests as References

You can add new requests as references to an existing request.

To reference a new request:

1.
2.

10.

1.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Request (New).

. Click Add.

The Create New Request window opens.
From the Request Type list, select the type of request you want to create.

Under Relationship, select the option that describes how the new request is
related to the open request.

Click Create.

The Create New <Request Type> window displays the fields available for
the selected request type.

Provide information for all required fields, and any optional information
you want to record.

Click Submit.

On the detail page for the original (open) request, the References to be
added on Save field lists the selected request.

Click Save.

In the References section of the request detail page, the Requests subsection
lists the new request you added.

Creating Requests
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Adding Tasks as References

You can add tasks as references to requests.

To reference an existing task:

1.
2.

10.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, select Task.

. Click Add.

The Add Reference: Task window opens.
Using the fields provided, enter your search criteria.
Click Search.

The Add Reference: Task window lists the tasks that match your search
criteria.

“Related to this Task” is the only relationship that can exist between requests and
tasks.

. In the Select Task to View section, select the checkboxes for the tasks that

you want to add as references to the open request.
Click Add.

On the detail page for the request, the References to be added on Save field
now list the selected task(s).

Click Save.

In the References section of the request detail page, the Tasks section lists the
task(s) you added.
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Adding URLs as References

You can reference an existing URL to a request.

To reference an existing URL:

1.
2.
3.

10.

Log on to PPM Center.
Open or create a request.

Scroll to, and then expand, the References section.

. From the New Reference list, sclect URL.

. Click Add.

The Reference URL window opens.

In the URL field, type the URL address.

To test the URL, click View URL.

In the Description field, you can type a brief description of the URL.
Click OK.

On the detail page for the open request, the References to be added on Save
field lists the URL you specified.

Click Save.

In the References section of the request detail page, the URLs section lists the
URL you added.

Creating Requests
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4 Processing and Managing Requests

Overview of Processing and Managing Requests

After a new request is submitted in HP Demand Management, it can be
processed and managed. Processing refers to updating requests and moving
them through their assigned workflow steps. Managing refers to performing
such actions as printing or purging requests.

To locate requests that require attention, do one of the following:

e View Portlets. Personalize HP Demand Management request portlets to
display only the requests that are assigned specifically to you.

e Perform Searches. Use the Search Requests page.

e Receive Notifications. As a request proceeds through its workflow steps,
email can be sent to notify you of pending actions. The notification might
include a link that you can click to open the referenced request.

If you are logged on to PPM Center, the referenced request opens. If you
are not logged on, the Logon page opens. After you log on, the referenced
request opens.

You can configure request types to send email notifications after:
o A request reaches a specific workflow step

o A specific field changes value
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Searching Requests
This section presents information on how to search requests in HP Demand
Management. You can search requests in the following ways:
e Conducting basic searches

e Conducting advanced searches to locate requests based on request
type-specific fields.

e Using the Query Builder

e Request Browser searches

Conducting Basic Request Searches

To conduct a basic request search based on the request number:
1. Log on to PPM Center.
2. From the menu bar, seclect Demand Management > Search Requests.
The Search Requests page opens.
3. In the View Details for Request field, type the request number.
4. Click Go.
To search for and list all requests:
1. Log on to PPM Center.
2. From the menu bar, sclect Demand Management > Search Requests.
The Search Requests page opens.

3. Click Search.
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To search requests based on values in one or more request fields:

1.
2.

6.

Log on to PPM Center.
From the menu bar, select Demand Management > Search Requests.
The Search Requests page opens.

In the Search for Requests to View section, provide values in one or more
of the enabled fields.

. In the Choose Columns section, select the columns to display in your

search results.

To save these search preferences:

a. In the Save this search as field, type a name for the search.
b. Click Save.

Click Search.

As you navigate pages in the PPM Dashboard, the pages you have viewed are
tracked. You can see links to these pages at the top of the PPM Dashboard.

) [ Project and Portfolio Management Center

Search Regquests > Search Resulis > Request Quick Edit

To return to a previous page such as the Search Results page, click the
corresponding link at the top of the page.
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Conducting Advanced Request Searches

You can conduct advanced searches to locate requests based on request
type-specific fields.

To conduct an advanced request search:
1. Log on to PPM Center.
2. From the menu bar, select Demand Management > Search Requests.
The Search Requests page opens.

3. In the Search for Requests to View section, use the Request Type
auto-complete to select one or more request types to include in the search.

The Advanced button is now enabled.
4. Click Advanced.
The Search page displays the fields for the request type(s) you selected.
5. Complete any of the request type fields.
6. To save these search preferences:
a. In the Save this search as field, type a name for the advanced search.
b. Click Save.

7. Click Search.

As you navigate pages in the PPM Dashboard, the pages you have viewed are
tracked. You can see links to these pages at the top of the PPM Dashboard.

) [ Project and Portfolio Management Center

Search Requests > Search Results > Request Quick Edit

To return to a previous page such as the Search Results page, click the
corresponding link at the top of the page.
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Using the Query Builder to Search Requests

To locate requests, you can perform simple searches based on generic request
fields, and more advanced searches based on the request fields for one or more
requests. If your administrator has assigned you the Demand Mgmt: Access
Request Query Builder access grant, you can also use the request query builder
to create custom search queries for request type-specific fields. You access the
query builder from the HP Demand Management Search Requests page.

Request Query Components

To use the query builder to construct a request query, you can combine
multiple search terms with logical operators and use comparison operators to
define search terms. A search term takes the following form:

<FieldName> <ComparisonOperator> <Value (s)>
where

<FieldName> is a field on a request.
<ComparisonOperator> is one of the operators listed in 7able 4-1.

<Value (s)> is one or more values that the field can accept.

Comparison Operators for Building Request Queries

Table 4-1 lists the comparison operators supported for building request queries
in HP Demand Management. In the Description column, the “value on the left”
refers to the value of the request field (in the request object), identified by
<FieldName> in the search term. The “value on the right” refers to the
<Value(s)> specified in the search term (in the query builder).
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Table 4-1. Supported operators for building queries

Operator Symbol Value Description
Greater than S Number/ Value on the Igft is greater than the
Date value on the right.
Number/ Value on the left is less than the
Less than < .
Date value on the right.
Greater than or o= Number/ Value on the left is greater than or
equal to Date equal to the value on the right.
Less than or < Number/ Value on the left is less than or equal
equal to Date to the value on the right.
Number/ Value on the left is equal to the value
Date on the right.
Equal to = Value on the left is the same as the
String value on the right (case-insensitive
match).
Number/ Value on the left does not equal the
Date value on the right.
Does notequal | != Value on the left is not the same as
String the value on the right
(case-insensitive match).
Number/ Value on the left matches one of the
Date values listed on the right.
In IN
Strin Value on the left matches one of the
9 values listed on the right.
Not in NOT IN
. . . The string on the right is a substring
Contains contains String of the string on the left.
The string on the right is the start of
Starts with startswith | String the string on the left
(case-insensitive).
The string on the right is the end of
Ends with endswith String the string on the left

(case-insensitive).
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Logical Operators for Building Request Queries
The logical operators for building a query are AND, OR, and NOT.
You can:
e Use AND/OR to link multiple search terms in a compound query.
e Prefix the NOT operator to any search term. For example:

Priority='High' AND Status='InProgress' AND NOT AssignedTo
IN {'johndoe', 'janedoe'}

Grouping Search Terms in Queries

You can group one or more search terms with parentheses to create complex
queries. For example:

(StartedOn > 5/5/06 AND StartedOn < 5/10/06) OR (StartedOn >
5/20/06 AND StartedOn < 5/30/06)

Using the Request Browser to Search Requests

To browse requests:

1. From the menu bar in the standard interface, select Demand Management >
Request Browser > Browse Requests.

The Browse Requests page opens.

2. In the Request Type field, enter the request type(s) of the requests you are
searching for.

) If you selected more than one request type, the Browse Requests page enables
only those fields common to all the request types you selected.

3. Enter information in all of the fields on which you want to base the search.

) You can also use the query builder to locate requests to browse. For information
on how to do this, see Using the Query Builder to Search Requests on page 65.

4. In the Choose Columns for Request List section, select the available
columns to include in the request pages you browse.
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5. Use the up and down arrows to the right of the Selected Columns field to
change the display order of the columns.

6. In the Choose Fields to Group by in Request Browser Tree section, select
up to five fields to group by in the Request Browser tree.

) You must select at least one field.

7. Use the up and down arrows to the right of the Selected Fields field to
change the display order of the fields.

8. To save this search, type a name for it in the Save this Preference Set as
field.

9. Click Browse.

Opening and Updating Requests
If you have the required security permission, you can open and update HP
Demand Management requests. This can involve:
e Searching requests
e Opening a request
e Changing information in request fields
e Adding notes or references to a request
e Performing an available action

The following sections address these tasks.
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Opening Requests from Portlets

HP Demand Management request portlets include links to the request detail
pages. To open the detail page associated with the request, in an HP Demand
Management portlet, click a Request No link.

The Request List portlet can also display links to detailed view of budgets, staffing
profiles, financial benefit, and referenced documents for request types such as PFM -

) Asset, PFM - Proposal, PFM - Project, and Project Details. This drill-down
functionality is security-based. If you do not have View, Edit, View All, and Edit All
access grants for an entity, associated values are not displayed as links.

For information about HP Demand Management portlets, see Managing
Requests Using Portlets on page 88 and Portlets on the Demand Manager
Page on page 99.

Opening Requests Using Email Notifications

Some workflow steps are configured to send email notifications upon
activation. Most email notifications include a link to the request.

To open the associated request, click the link. If you are logged on to PPM
Center, the referenced request opens. If you are not logged on to PPM Center,
the PPM Center Logon page opens. After you log on, the referenced request
opens.

Opening Requests from the Menu Bar

To open a request from the menu bar:
1. Log on to PPM Center.
2. From the menu bar, select Demand Management > Search Requests.

3. On the Search Requests page, enter your search criteria, and then click
Search.

4. On the Request Search Results page, in the Req# column, click the number
that corresponds to the request you want to open.

The detail page for the request opens.
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Performing a Basic Request Edit

To perform a basic request edit:
1. Open a request to edit.

The Available Actions section contains buttons for the actions that you have
permission to perform.

2. To act on the request, in the Available Actions section, click a button.

Some actions, such as Accept and Reject, move the request to the next step
in the workflow and require no additional input. Other actions, such as
Assign Resource or Delegate Decision, require that you provide additional
information.

If you are required to provide more information, a workflow step action
page(s) opens. To complete the action, provide the required information.

Some actions change the status of a field. For example, a disabled field can
become enabled or required (marked with a red asterisk). Check the Header
and Details sections for newly enabled or required fields.

A request can have a reference relationship that places it on hold until
another request (or other referenced entity) is completed. If the request has
such a reference relationship, the Available Actions section contains the
Override button. To override the referenced relationship and allow the
request to continue through the workflow, click Override.

3. In the Header section, complete the fields, as required.

The Header section includes general information about the request.
Required fields are marked with a red asterisk. All other fields are optional.
For information about a specific field, click the Help icon (if available) next
to the field.

If necessary, you can change the request type. For example, you can
change a bug request to an enhancement request.

Changing the request type can involve changing the fields are associated
with the request. To reduce data entry if the request type is changed, HP
Demand Management maps the fields from the original request type to the
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fields for the new request type. New fields contain no values. To change
the request type, next to the Request Type field, click Change.

4. In the Details section, complete the fields, as required.

The Details section includes specific information about the request. It can

contain one, several, or no subsections. Required fields are marked with a
red asterisk. To view more information about a specific field, click the Help
icon (if available) next to the field.

5. In the Notes section, type additional information about the request that you
want to record.

The Notes section contains fields in which you can type notes about the
request that you want to keep. To add a note, in the Add Note section, type
the data. After you save the request, the note is added.

View existing notes in the Existing Notes section. Existing notes are listed
in chronological order, with the most recent note at the top. To filter the
notes for display, do one or more of the following:

e To display only the notes that users have entered, select the Show Only
User Notes checkbox.

e To display notes that a specific user added, from the Note Author list,
select the user name.

e To display only notes related to a changed value in a specific field,
from the Changed Fields list, select the field name.

6. In the Status section, review the request status.

The Status section lists all of the workflow steps and the status of each.
The current workflow step is highlighted.

In addition to the list of workflow steps, the Status section includes the
following links:

e Graphical View. Displays the workflow associated with the request.

e Approval Details. Displays a detailed view of approved and completed
workflow steps.
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e Transaction Details. Displays detailed information about each
completed workflow step transaction.

If the workflow step is an execution workflow step, it may be linked to a
request execution log. To view the request execution log for a particular
workflow step, in the Step Status column, click log.

If you have the permission required to act on an eligible step, the Step
Status column displays the View Available Actions link. To display the
action page for a workflow step, click View Available Actions.

The actions available on the action page are the same as those displayed in
the title section for the request. To move the request to the next workflow
step, complete the action.

7. Use the References section to add references to the request.

You can view existing references in subsections of the References section.
Existing references are grouped by entity type. For example, referenced
requests are listed in the Requests section.

To change the relationship of an existing reference, from the Relationship
list, select a different relationship. To delete a reference, click the Delete
icon to the left of the reference name.

In some cases, you might want to reference a Web-accessible file or a
document or file from a local machine to the request. You can also add
other entities such as packages, tasks, or other requests as request
references. For information about how to add references, see Adding
References to Requests on page 48.

8. Click Save.

As you navigate pages in the PPM Dashboard, the pages you have viewed are
tracked. You can see links to these pages at the top of the PPM Dashboard.

[ Project and Portfolio Management Center

To return to a previous page such as the Search Results page, click the
corresponding link at the top of the page.
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Editing Requests Simultaneously

If two users edit the same request at the same time, and then click Save, HP
Demand Management attempts to save the changes that both users make. If a
change is not saved, HP Demand Management notifies the user who entered it,
and advises that user to make the change and save it again.

Example: Two Users Editing Fields

Two users, Otumbo and Monette, are working in different locations and
editing the same request.

e Otumbo makes changes to the Assigned To and Department fields, and
adds text to the Notes field.

e Monette makes changes to the Assigned To and Company fields, and adds
text to the Notes field.

1. Otumbo clicks Save first.
All of his changes are saved.
2. Monette clicks Save next.

Monette’s Notes are saved, but a message at the top of the request informs
her that another user has made changes to the request, and displays these
changes. Monette must re-enter her changes to the Assigned To and
Company fields.

3. Monette again changes values in the Assigned To and Company fields, and
then clicks Save.

The changes are saved.
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Example: Two Users Editing Fields Plus Workflow Action

Two users, “Otumbo” and “Monette,” are working in different locations and
editing the same request. They both have permission to move the request to its
next workflow step.

1. Otumbo adds to the request Notes section, and then clicks the workflow
action button.

Otumbo’s changes are saved and the request advances along its workflow.

2. Monette adds an attachment to the request, and then clicks the workflow
action button.

The attachment to the request is saved, but a message at the top of the
request informs Monette that the workflow action she attempted has
already been performed. No further action is necessary.

Example: Parallel Workflow Steps

Otumbo and Monette are editing the same request that is being processed along
parallel branches of a workflow. Both users can process the request along these
parallel branches independently without problems.
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Quick Edits: Editing Multiple Requests at the Same Time

HP Demand Management’s quick edit feature lets you modify many requests
from a single page at the same time. Simply search for requests that you want
to edit. From the list of results, select those that you wish to edit, and click
Quick Edit. The selected requests are displayed line-by-line in the
spreadsheet-style interface on the Modify Requests page. You can edit the
enabled fields for each listed request individually, and then save them all
simultaneously.

Performing quick edits is convenient if, for example:

e In searching for unassigned requests, you find 20 new requests that you
must handle. Of these requests, you want to assign 15 of them to specific
resources immediately, and specify a priority for each.

e After you locate all new requests of the DEM - Application Bug type, you
want to specify the priority and ensure that the correct application is
specified for each of these.

Considerations for Performing Quick Edits

The quick edits you perform in HP Demand Management have the following
limitations:

® You can only perform a quick edit on requests that are all of the same type.
So, when you search requests, select only one request type if you plan to do
a quick edit.

e Advanced Ul rules that have been set up for requests do not work during
quick edits. For example, any Ul rules defined to dynamically show or hide
a field, change the field styling, or make a field required, are not applied
while a user performs a quick edit. However, upon saving the requests, any
fields that would have been dynamically required based on other edits
made by the user are enforced.
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e You can update standard request fields (such as text fields, date fields, and
lists), but you cannot edit complex components such as attachments, table
components, and entity-chooser components (for example, staffing profiles
or budgets) during a quick edit.

e You cannot perform quick edits to take workflow actions or to update
aspects of a request other than basic field values. For instance, you cannot
add notes, interact with references, or manage resources during a quick
edit.

Quick Edits: Error Handling

When you click Save or Done, the system attempts to save all of the requests
you have updated. If problems are encountered, it displays a list of the requests
that could not be saved and the reasons the saves failed.

Errors can occur if:

e A request was updated by a different user in another session before you
saved your changes.

e A Ul rule to make an empty field required was triggered on save (see
Considerations for Performing Quick Edits on page 75).

Chapter 4



Performing Quick Edits
To perform a quick edit on a set of requests:
1. Search for a set of requests of the same type that you want to update.

The Request Search Results page opens and lists your search results.

[ Project and Portfolic Mana ent Center SIGH ouT

Search Requests > Search Resulis

[® s Export to Excel Modify Sea

Save this search as! Save mm%

Request Search Results Showing 1 - 14 of 14
Req#¥v Description Status Created By Priority Workflow Creation Date

H 30511 Inventory doesn't match transaction details New Admin User Mormal DEM - Bug Reguest Workflow February 22, 2008

[} 30510 Loan details unavaiable in IE New Admin User High DEM - Bug Reqg February 22, 2008

EER CEM app throwing exceptions on save New Ldmin User Hormal DEM - Bug Reques February &, 2008

B Application miseing module for new Ops divigion New Admin User High DEM - Bug Regues February &, 2008

1] reguest 1 In Further Review Admin User Normal DEM - Bug Reguest Workflow July &, 2007

O 30254 Cannot access Euro email groups New Admin Uzer Low DEM - Bug Reguest Workflow October 11, 2008

1] 30253 inventory counts do not transaction details In Further Review Admin User Normal DEM - Bug Reguest Workflow October 10, 2006

ﬂgckg Clear Alll Edit v Delete Showing 1-14 of 14

[® s Export to Excel Modify Seal

2. Select the checkboxes for the requests on which you want to perform a
quick update.

3. Below the list of requests, click Edit, and then select Quick Edit.

A Project and Portfolio Management Center SIGN OUT

Request #30481 > Search Reguests > Search Results > Request Quick Edit > Request Quick Edit

Modify Requests

Req# Description Status Created By Priority Workflow Creation Date
30480 Application missing New Admin User * High DEM - Bug Request Waorkflow Feb 6, 2008
* medule for new Ops
divigion
30481 . CSM app throwing New Admin User * Normal DEM - Bug Reguest Workflow Feb 8, 2008
exceptions on save
30510 . Loan detaile New Admin User * High DEM - Bug Reguest Workflow Feb 22, 2008
unavailable in [E.
30511 Inventory dossn't New Admin User * Normal DEM - Bug Request Workflow Feb 22,2008
* match transaction
details

The Modify Requests page opens and lists the requests you selected.
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4. Click the row that displays a request you want to edit.

The fields you are authorized to edit become enabled.

[ Project and Portfolio Management Center SIGH OUT
| g

Search Requests > Search Results > Request Quick Edit

Modify Requests

Req# Description Status Created By Priority Workflow Creation Date
30480 [appicatin masing maduls o nev. Opadvaon| || New | Admn [gn  v] | DEM-BugReauest Febs, 2008
User Workflow
30481 * CSM app throwing exceptions on save Hew Admin * Normal DEM - Bug Reguest Feb €, 2008
User Workflow
30510 * Loan detailz unavaiable in IE New Admin * High DEM - Bug Reguest Feb 22
User Workflow 2008
30511 * Inventory doesn't match transaction details New Admin * Normal DEM - Bug Request Feb 22
User Workflow 2008
Save | Done Cancel

5. Make changes to the enabled fields you want to edit.
6. For each of the remaining requests, repeat step 4 and step 5.

7. To save your updates and remain in the Modify Requests page, click Save.
To save your updates and close the Modify Requests page, click Done.

You can also use quick edit functionality from the Request Browser. For instructions
) on how to use the Request Browser to search requests, see Using the Request
Browser to Search Requests on page 67.

As you navigate pages in the PPM Dashboard, the pages you have viewed are
tracked. You can see links to these pages at the top of the PPM Dashboard.

" L1 Project and Portfolio Management Center

Search Requests > Search Results > Request Quick Edit

To return to a previous page such as the Search Results page, click the
corresponding link at the top of the page.
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Mass Updates: Acting on Multiple Requests at the Same Time

If you want to perform the same action on multiple requests of the same type,
you can use the mass request update feature to do it. Just search for requests of
a given type, and then update the entire set of requests at the same time instead
of updating each individual request.

Following are some examples of situations in which mass updates are useful:

e A development manager searches for all new defect requests. He wants to
assign 20 of them to the same developer. This involves updating the
Assigned To field on all 20 requests, and pushing them from New to
Assigned status.

e Fifteen requests are currently assigned to you. Because you are going on an
extended vacation, you need to reassign all of these requests to another
engineer.

e You need to add the same specific stakeholders to escalations from a
particular customer account so that management can be copied on emails
generated by activities to these escalations.

You can quickly and easily handle cases such as these by mass request updates.

Considerations for Performing Mass Updates

As you prepare to use the request mass update feature, be aware of the
following restrictions:

e Only one request type is supported for batch update.

e You can update standard request fields (such as text fields, date fields, and
lists), workflow actions, and you can add notes to requests. You cannot
perform mass updates on complex components such as attachments, table
components, and entity-chooser components (such as staffing profiles and
budgets).

e Advanced UI rules that have been set up for requests do not work during
mass updates. For example, any UI rules defined to dynamically show or
hide a field, change the field styling, or make a field required, are not
applied while a user performs a mass update. However, upon saving the

Processing and Managing Requests 79



80

requests, any fields that would have been dynamically required based on
other edits made by the user are enforced.

If all of the requests you select to update are active at the same workflow
step, you can take action on that step for all of the requests. However, you
can update only one active workflow step at a time.

In addition, consider how the updates might affect automated processes. Any

updates you perform may trigger subsequent updates to additional, dependent
fields.

Mass Updates: Error Handling

When you click Save or Done, the system attempts to save all of the requests
you have updated. If problems are encountered, it displays a list of the requests
that could not be saved and the reasons the saves failed.

Errors can occur if:

A request was updated by a different user in another session before you
saved your changes.

A Ul rule to make an empty field required was triggered on save (see
Considerations for Performing Mass Updates on page 79).

Performing Mass Updates

To use the request mass update feature:

1.
2.

Log on to PPM Center.
From the menu bar, select Demand Management > Search Requests.
Search for requests of the request type that you want to update.

On the Request Search Results page, select the checkboxes for the requests
to update.

Click Edit, and then select Mass Update.

The Modify Requests page opens and lists the selected requests.

Chapter 4



6. Do any of the following:

e [fthe Available Actions section is available, you can click an action
button to take action on the same workflow step for all the selected
requests.

e To enter the same description for all the requests, type it into the field
below the Description column.

To empty the Description field for all the requests, below the
Description column, select the Apply Blank checkbox.

e To assign the same resource to all the requests, use the auto-complete
under the Assigned To column to specify the name of the resource to
assign.

To empty the Assigned To field for all the requests, below the Assigned
To column, select the Apply Blank checkbox.

e To assign the same priority to all the requests, from the Priority list
below the Priority column, select the priority value.

To empty the Priority field for all the requests, below the Priority
column, select the Apply Blank checkbox.

) You can only use mass update on the columns for which fields are provided.

7. Click Done.

The Request Mass Update Confirmation window opens and lists the
changes you are about to make.

8. To confirm that this is what you want to do, click Continue.

You can also use mass update functionality from the Request Browser. For
) instructions on how to use the Request Browser to search requests, see Using the
Request Browser to Search Requests on page 67.

If any of the changes you specified could not be implemented, a message to
that effect is displayed in the upper left corner of the page next to the warning
icon £1% along with a link to view a separate window that lists of all requests
that could not be saved, and a description of the reasons.
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As you navigate pages in the PPM Dashboard, the pages you have viewed are
tracked. You can see links to these pages at the top of the PPM Dashboard.

) [ Project and Portfolio Management Center

Search Requests > Search Results > Request Quick Edit

To return to a previous page such as the Search Results page, click the
corresponding link at the top of the page.

Managing Requests

After you submit a request in HP Demand Management, users who have the
required permission can view, change, or delete that request, depending on
changes to the business requirements or workflow.

Reopening Closed Requests

You can reopen a request at a preconfigured step in the workflow. For
example, if a defect request is closed and the defect recurs, you can reopen the
request.

To reopen a request:
1. Log on to PPM Center.

2. Search for and open the request.

) For information on how to open a request, see Opening and Updating Requests
on page 68.

The request detail page opens.
3. Scroll to the Status section.
4. Click Reopen Request.

The request reopens.
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Deleting Requests

You can only delete saved requests from PPM Center. To delete a request, you
must have either the Demand Mgmt: Edit Requests access grant or the Demand
Mgmt: Edit All Requests access grant. Deleted requests can no longer be
opened or viewed.

To delete a request:
1. Log on to PPM Center.

2. Search for and open the request.

) For information on how to open a request, see Opening and Updating Requests
on page 68.

The request detail page opens.
3. Scroll to the bottom of the page.
4. Click Delete.

HP Demand Management prompts you to confirm that you want to delete
the request.

5. Click OK.
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Cancelling Requests

You can only cancel saved requests in PPM Center. To cancel a saved request,
you must have either the Demand Mgmt: Edit Requests access grant or the
Demand Mgmt: Edit All Requests access grant.

To cancel an existing request:

1.
2.

Log on to PPM Center.

Search for and open the request.

. On the request detail page, scroll to the Status section.

Click Cancel Request.
HP Demand Management prompts you to confirm the cancellation.
Click OK.

This cancels each workflow step and sets the request status to Cancelled.
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Printing Requests

You can print the detail page for a request.

) You cannot modify the printable version of the detail page.

To print a request:
1. Log on to PPM Center.

2. Search for and open the request.

) For information on how to open a request, see Opening and Updating Requests
on page 68.

The request detail page opens.
3. At the top of the page, click Print Business Case.
A printable version of the page opens in a new browser window.

4. On the printable version of the page, click Print.

Purging Requests

You can delete multiple requests at the same time (if you have the required
permissions). You cannot open or view deleted requests.

To purge multiple requests:
1. Log on to PPM Center.
2. Search for the requests to purge.
The search results page opens.

3. In the Request Search Results section, select the checkboxes that
correspond to the requests you want to delete.

4. Click Delete.
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Managing Requests Using Reports

HP Demand Management includes a predefined set of reports, which are listed
in Table 4-2. If you have the System: Submit Report access grant, you can
generate these reports at any time to monitor request activity.

Table 4-2. HP Demand Management reports (page 1 of 2)

Report Name

Description

Contact Detail

Queries the contacts already entered in the HP
Demand Management system that are available
for entering and updating requests.

Demand Creation History

Shows the history of demand creation for a
specified demand set. This report is useful for
exporting request data to Microsoft® Excel or
other data analysis tool.

Historical SLA Violation

Shows the history of SLA violations for a
specified demand set. This report is useful for
exporting request data to Microsoft Excel or
other data analysis tool.

Import Requests

Validates and loads request data from the HP
Demand Management open interface tables into
the standard HP Demand Management data
model.

Satisfied Demand History

Shows the history of demand that has been
satisfied for a specified demand set.

Request Detail

Provides information about requests using
several selection criteria.

Request Detail (Filter by
Custom Fields)

Similar to the Request Detail report except that
requests can be filtered based on values in
custom fields.

Request Header Type Detail

Provides the configuration details for request
header types. This report is useful in auditing
your setup and for debugging problems you
might have with specific request header types.
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Table 4-2. HP Demand Management reports (page 2 of 2)

Report Name Description

Lists the complete workflow and field change
history for each selected request. Details include
Request History the complete request workflow history and fields
configured for auditing with every status change
for every step traversed.

Provides a summary of open and closed

Request Quick View requests, organized based on priority.

Displays the total counts for groups of requests

Request Summary matching the selection criteria.

Similar to the Request Summary report except
that requests can be filtered based on values in
custom fields.

Request Summary (Filter by
Custom Fields)

Displays configuration information for request
types, including details about custom fields,
possible status values, default logic, and
commands used with each request type.

Request Type Detail Report

For more information on how to configure and run these and other predefined
reports in PPM Center, see the Reports Guide and Reference.
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Managing Requests Using Portlets

You can use the HP Demand Management request portlets to organize and
present request information and drill down on displayed data to view more
detail. Table 4-3 lists the demand-related portlets that you can add to your
PPM Dashboard pages (including the preconfigured Demand Manager page)
and customize to suit your information needs.

For information about the default portlets displayed on the Demand Manager
page, see Portlets on the Demand Manager Page on page 99. For information
about how to configure the information displayed in a portlet, see Setting
Portlet Preferences on page 104.

Table 4-3. Demand-related portlets (page 1 of 4)

Portlet Name

Description

Assignment Queue

The Assignment Queue portlet provides a
customizeable view of the demand that has not yet been
assigned to a resource. Use this portlet to assign a
resource to a request.

Consolidated Demand

This portlet displays a bar graph that provides a
graphical overview of the demand placed on an
organization. Drill-down functionality lets users view
details about the requests represented.

Demand by Category

The Demand by Category portlet provides graphical
summary view into different aspects of demand. You
can organize the information displayed in the portlet
based on department, demand type, priority value, and
so on. You can also organize the displayed information
based on the number of demand entries within a specific
grouping (count) or the consolidated effort of the
grouped demand.

The Demand List portlet provides a list of the demands
placed on an organization or resource. You can

Demand List configure this portlet to display demand information
filtered based on criteria such as demand type, assigned
priority value, demand disposition, and so on.

Issue List Lists open issues associated with programs.
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Table 4-3.

Demand-related portlets (page 2 of 4)

Portlet Name

Description

My Requests

The My Requests portlet displays all requests created
by or assigned to the user, and which are at a workflow
step that the user can act on. This portlet provides a
view of the most pressing requests. By default, the
portlet displays all requests (with a current active step)
created by or assigned to the user, so that the user can
see the information without having to customize the
portlet.

Open Requests by
Priority

This portlet displays a graphical view of the number of
open requests, grouped by assigned priority value. Use
this portlet to help you visualize and group open issues.

Program Risk List

This portlet lists risks associated with projects that are
linked to programs. You can personalize this portlet to
display risks based on project, impact, probability of
occurrence, impact level or other criterion. You can
configure the portlet to display only the programs that
are relevant to your assigned activities.

Program Scope Change
List

The Program Scope Change List portlet displays all of
the scope change requests associated with projects that
are linked to programs. You can configure multiple
instances of this portlet for viewing different programs
and the scope changes logged against their linked
projects.

You can personalize the portlet to display scope change

requests based on criteria such as project name,
severity, change request level, and so on.

Request Activity

This portlet displays general activity information such as
the number of requests opened and closed during the
previous two weeks, and the number of open requests.
This portlet provides visibility into high traffic request
types as well as the groups or users assigned to
address them.

Processing and Managing Requests
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Table 4-3.

Demand-related portlets (page 3 of 4)

Portlet Name

Description

Request List

This portlet displays general request information,
including description and status. You can click the Req#
link to open the detail page for the corresponding
request.

If you configure the portlet to display the following
columns (for requests such as for request types such as
PFM - Asset, PFM - Proposal, PFM - Project, and
Project Details), and you have the permissions required,
you can click the values in these, which are also links to
their corresponding entities in PPM Center:

e Budget

o Staffing Profiles

¢ Financial Benefit

e Reference Documents

The drill-down functionality in this portlet is
security-based. If you do not have View, Edit, View All,
and Edit All access grants for an entity, its values will not
be displayed as links.

Request References

The Request References portlet lists the references
attached to request based on filters such as reference
type, relationship, and the time period the references
were added.

Request Summary

This portlet displays information about groups of
requests, including assigned priority, request type, and
the total number of requests in each category. You can
drill down on any request or request group.
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Table 4-3. Demand-related portlets (page 4 of 4)

Portlet Name

Description

Request Summary Bar
Chart

This portlet displays a bar chart that lets you see rolled
up information about selected requests. To see the list
of requests that a bar represents, click the bar.

Request Summary Pie
Chart

This portlet displays a pie chart that presents rolled up
information about requests that you select. To see the
list of requests that a pie wedge represents, click the
wedge.

SLA Exception Roll Up

This portlet provides a graphical display (bar chart) of all
open demand under active service level agreements
(SLA). The SLAs are configured using request type
rules. According to your information needs, you can
group the SLA information based on department,
application, demand type, and other criteria.

Violations are highlighted in red. To see a list of violating
requests, click View These Exceptions.

HP supplies a preconfigured Demand Manager page that contains
request-related default portlets for use by demand managers. For detailed
information about the Demand Manager page, and instructions on how to add
it to your PPM Dashboard, see Chapter 6, Demand Manager Page, on page 97.
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|
5 Integrating Requests and Projects

Overview of Integrating Requests and Projects

Customers who have both HP Demand Management and HP Project
Management can integrate HP Demand Management’s request tracking
capability with HP Project Management’s deliverable date and actuals tracking
capabilities. By integrating HP Demand Management and HP Project
Management, requests can be folded seamlessly into a scalable framework of
interlocking initiatives.

Linking tasks to requests from HP Demand Management also gives instant
visibility into the detailed activities that support a project. The possible
relationships between projects, tasks, and requests are as follows:

o Reference Tasks to Requests. You can use the References tab on the Task
Details page to link a task to new and existing requests.

e Reference Projects from Requests. You use the can use the References tab
on the Task Details page to reference existing projects from requests. For
information on how to reference a project from a request, see Overview of
Adding References to Requests on page 47.

e Reference Tasks from Requests. You use the can use the References tab on
the Task Details page to reference existing tasks from requests. For
information on how to reference a task from a request, see Overview of
Adding References to Requests on page 47.

As you integrate requests and projects, dependencies are established between
the two entities. For example, you can specify a request as a predecessor to a
package. This means that the package cannot continue along its workflow until

23



the request is closed. Table 5-1 lists the dependencies that you can create
between requests and tasks and requests and projects.

Table 5-1. Dependency relationships

Dependency

From Enfity to Entity | gfationship

Description

From Request to
Task

(Informational) The selected task

Related to this request is related to the request.

From Request to
Project

(Informational) The selected

Related to this request project is related to the request.

(Informational) The selected

From Project to Related to this project | request (new or existing) is

Request related to this project.
From Task to . (Informational) The selected
Request Related to this task request is related to the task.

For more information about relationships, see Request Detail Page, References
Section on page 28.

Referencing Requests from Tasks

To reference a request from a task:
1. Log on to PPM Center.

2. From the menu bar, select Project Management > Projects & Tasks > Search
Projects.

The Search Projects page opens.
3. Enter your search criteria.
4. Click Search.
The Project Search page reloads and displays the search results.

5. To open a project, from the Project Name list, click the project name.
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6. On the Project Summary tab, at the top of the Work Plan section, click Edit
Work Plan.

The View Work Plan page opens to the Schedule View.

7. In the list of tasks, select the task to update, and then click the Task Details
icon.

The Task Details page opens.
8. Click the References tab.
9. From the New Reference list, select Request (Existing) or Request (New).
10. Click Add.

If you selected Request (Existing), the Add Reference - Request page
opens. If you selected Request (New), the Create New Request window
opens.

11. If you selected Request (Existing), do the following. Otherwise, skip to
step 12 on page 96.

a. On the Add Reference: Request page, enter your search criteria, and
then click Search.

The Request Search Results section lists the requests that match your
search criteria.

b. In the Request Search Results section, select the checkbox for the
request you want to add as a reference.

c. Click Add.

The Add Reference: Request page closes and the Task Details page
opens. On the References tab, the References to be added on Save field
displays the request you selected.
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12. If you selected Request (New), do the following in the Create New Request
window:

a. In the Request Type field, select the request type.

You can only specify the “Related to this Task” dependency between requests
and tasks.

b. Click Create.
The Create New <Request Type> window opens.

c. Provide all required information (marked with a red asterisk) and any
useful optional information, and then click Submit.

The Create New <Request Type> window closes and the Task Details
page opens. On the References tab, the References to be added on Save
field displays the request you just created.

13. Click Done.

The request is referenced to the task. The Task Details page closes, and the
View Work Plan page opens.

14. To save your changes to the work plan, click Done.

Visibility into Tasks and Requests

96

You can view references related to your tasks and projects using the Project
References portlet on your PPM Dashboard. Add the portlet to your PPM
Dashboard, and then personalize it to show the references that are relevant to
your activities. You can configure the portlet to display references based on the
following:

e Reference types
e Relationship
e Time period during which they were added

e Whether they prevent actions on tasks
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6 Demand Manager Page

Overview of the Demand Manager Page

HP Demand Management comes with a preconfigured Demand Manager page
(shown in Figure 6-1) that displays a default set of portlets for use by demand
managers. You can display additional demand-related portlets on the page, and
customize the data that each portlet displays, according to your information
needs.

This chapter contains descriptions of the default portlets displayed on the
Demand Manager page, and descriptions of the demand-related portlets that
you can add to the page. It also provides information about how to customize
the portlets displayed on the page. For information on how to add the Demand
Manager page to your PPM Dashboard, see the Getting Started guide.
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Figure 6-1. Demand Manager page
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Portlets on the Demand Manager Page

This section provides description of the default portlets displayed on the
Demand Manager page. For information on how to personalize these portlets,
see Setting Portlet Preferences on page 104.

Consolidated Demand Portlet

The Consolidated Demand portlet (Figure 6-2) provides a graphical overview
of the demand placed on your organization. Drill-down functionality lets you
edit parameters.

To display descriptions of all the filter fields that you can use to configure for
the Consolidated Demand portlet, at the top right corner of the portlet, click the
Help icon [d.

Figure 6-2. Consolidated Demand portlet
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Demand by Department Portlet

The Demand by Department portlet (Figure 6-3) provides a graphical
summary view of different areas of demand. You can customize the portlet to
display demand information based on department, demand type, priority, and
so on. You can also configure the portlet to grouped information based on
number of demand entries within a specific grouping (count) or the
consolidated effort of the grouped demand.

Figure 6-3. Demand by Department portlet
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To display descriptions of all the filter fields that you can configure for the
Demand by Department portlet, at the top right corner of the portlet, click the
Help icon 7 §
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Demand by Business Initiative Portlet

The Demand by Business Initiative portlet (Figure 6-4) provides a graphical
view of different aspects of demand. This portlet provides a summary in which
demand can be grouped by department, demand type, priority, and so on.

You can also customize this portlet to display the grouped information based
on the number of demand entries within a specific grouping (count) or the
consolidated effort of the grouped demand.

Figure 6-4. Demand by Business Initiative portlet
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To display descriptions of all the filter fields that you can configure for the
Demand by Business Initiative portlet, at the top right corner of the portlet,
click the Help icon [HE.
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SLA Exceptions by Department Portlet

The SLA Exceptions by Department portlet (Figure 6-5) displays a bar chart of
all open demand under service level agreements (SLA). The SLAs are
configured using request type rules. The portlet displays the active SLAs

related to demand, highlighting the violations in red.

To see a list of the violating requests, click View These Exceptions. You can
personalize the SLA information displayed in this portlet by filtering demand
based on department, application, demand type, and so on.

Figure 6-5. SLA Exceptions by Department portlet
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To display descriptions of all the filter fields that you can configure for the
SLA Exceptions by Department portlet, at the top right corner of the portlet,

click the Help icon [H.
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Initiatives Pending Approval Portlet

The Initiatives Pending Approval portlet (Figure 6-6) displays general

information about PPM Center requests, including request description and
status. This portlet can be filtered for the same request criteria as the Request
List portlet, but displays more detailed request information.

You can personalize this portlet to display the same information displayed in
the Request List portlet, but in more detail.

Figure 6-6. Initiatives Pending Approval portlet
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To display descriptions of all the filter fields that you can configure for the

Initiatives Pending Approval portlet, at the top right corner of the portlet, click
the Help icon [H.

Demand Manager Page
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Setting Portlet Preferences
You can determine which data a portlet displays and, to some degree, how it
displays the data.
To set the preferences for a portlet:
1. Log on to PPM Center.
2. Open the PPM Dashboard page that displays the portlet you want to edit.
3. In the top right corner of the portlet, click the Edit icon.
The Edit Preferences: <Portlet Name> page opens.
4. To change the portlet title displayed on the page:
a. At the top of the page, click Change Title.
The Edit Portlet Title window opens.
b. In the Title field, select the current title, and then type a new title.
c. To save the title, click Change.

5. In the Preferences and Choose Display Columns sections, make any
necessary changes.

) To see a description of the controls in the Preferences section, return to the
portlet, and, in the upper right corner, click the Help icon.

6. Click Done.
The portlet reflects your changes.
For information about working with portlets, see the following documents:
e Creating Portlets and Modules
e Customizing the Standard Interface

e Getting Started.
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